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Through the work carried out over 2 years within the framework of the
Erasmus Plus project “Virtual lifelong learning centers E2.0C” a new
educational model has been generated to develop second-chance schools by
promoting the inclusion of young adults through training in entrepreneurship
and employability in the third sector.

One of the keys to our work is the creation of a new technological framework
that includes an innovative e-Learning platform that provides a framework
that is as friendly and as close as possible to the personal situation of our target
audience, adapting it to the second chance model in adult education that we
are developing under the name “E2.0C”. In this way, we provide a digital
environment that is similar to that of any real educational center and therefore
avoids resorting to tools that may pose a barrier or limit accessibility to
training. 

Our platform allows any trainer from an entity interested in our
methodological model to build their own E2.0C center, which will have a
secretary office, adapted synchronous and asynchronous virtual classrooms, an
open library with materials and bibliography, a laboratory for virtual
volunteering practices, a cafeteria where they can interact with other peers
through various formats (forum, chat, direct messaging…) a space for the
preparation of physical and virtual mobilities… The objective of creating this
platform is to provide students with a less rigid and easier to operate
environment than other tools in use, so they can be more easily attracted and
linked to the training resources of the E2.0C center.
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The contents of these E2.0C training centres can be structured in different
ways and combined with various digital formats on the basis of specific
sessions that culminate in a self-assessment knowledge test that allows the
student to know the extent of their own understanding of new knowledge
and, when appropriate, the need to reinforce it. This type of test consists of
questions with alternative answers of which only one is correct and takes place
throughout the development of the contents also as a self-evaluation. Only at
certain selected points of the training will the tests be used by the entity
leading the centre to assess the knowledge acquired and provide the
appropriate certification for it. These sessions will be supported by the
development of synchronous meetings with teaching tutors or with experts in
the subjects of non-profit or third sector organisations of the social economy in
the classrooms and spaces of each virtual centre. The platform thus allows the
development of virtual lessons, masterclasses, direct or deferred tutorial
attention, group work in a shared space or documents, in order to provide the
framework to develop a part of our methodology focused on practical training
through the development of social projects, executing their planning and
development in parallel to the progress in the training content taught that will
reinforce practical learning. This can be carried out both individually and in
groups, also counting on continuous tutorial attention, guiding users in a
practical learning journey in the management of projects and entities with a
cumulative and interrelated nature, which must culminate in a great final
result. 

In this result we provide the template with all the necessary elements so that
any social or educational entity can launch its own E2.0C educational center
(2.0 second chance center) along with the necessary software, plans, and
appropriate documents to shape, strengthen, and replicate new educational
centers that contribute to disseminating our pedagogical objectives of social
reintegration.
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CREATION OF THE
INFRAESTRUCTURE
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As a first step, choose a domain name and a provider to
manage it. If you don’t have one, you can also buy a hosting
service together with the domain.

1.1. PRELIMINARY ACTIVITIES

STEP 1STEP 1

STEP 2STEP 2 Once you have a domain, you need to install WordPress. To
do so, follow these basic instructions:

Download and unzip the WordPress package here.
Create a database for WordPress on your web server, as well as a MySQL
user who has all privileges for accessing and modifying it.
Upload the WordPress files to the desired location on your web server:

If you want to integrate WordPress into the root of your domain (e.g.
https://example.com/), move or upload all contents of the unzipped
WordPress directory (excluding the WordPress directory itself) into the
root directory of your web server.
If you want to have your WordPress installation in its own subdirectory
on your website (e.g. https://example.com/blog/), create the blog
directory on your server and upload the contents of the unzipped
WordPress package to the directory via FTP.
Note: If your FTP client has an option to convert file names to lower
case, make sure it’s disabled.

Run the WordPress installation script by accessing the URL in a web
browser. This should be the URL where you uploaded the WordPress files.
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WordPress should now be
installed.

If you installed WordPress in
the root directory, you should
visit: https://example.com/

If you installed WordPress in its
own subdirectory called blog,
for example, you should visit:
https://example.com/blog/
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For more details instructions

1.2. CREATION OF THE SITEMAP

Enter the WordPress application with your credentials and
start creating the sitemap. STEP 1STEP 1

From the main menu on the left select Pages and create
the main page, the Home page. STEP 2STEP 2

Then go to Settings > Reading and set the page you’ve
created as the homepage of the website. STEP 3STEP 3

Then proceed creating the other pages by reproducing this
tree structure as exemplified in the image below:STEP 4STEP 4
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1.3. MAIN MENU

From the dashboard menu select Plugins > Add new plugin
and search for these three plugin that will allow you to
create a navigation menu with login and logout option and
a conditional visibility for each menu item:

QuadMenu 
Login or Logout Menu Item
If Menu

STEP 1STEP 1

Once the plugins are installed, go to Appearance > Menu
and create the main menu. Give it a name and start adding
the pages and subpages you want to appear in your menu.

STEP 2STEP 2

Finally add the login and logout buttons and respectively
add their conditional visibility by clicking on Enable
visibility rules.

STEP 3STEP 3

Main entranceInformation Admissions

Access

Student Teacher

Admin

News board

Library

Cafeteria

Main hall

Courses
Lab Masterclass

Administrator

Admin Admin

Main hall

Calendar

Application
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For the login button select ‘Hide’ if ‘is logged in’ - For the logout button select
‘Show’ if ‘is logged in’.

You can then return to this menu and decide to hide or show certain pages to
certain types of users, after you have created them (as we will see in Chapter 2).

1.4. PAGE CUSTOMIZATION

Download the plugin here

You can start customising your pages by trying to convey the idea of a virtual
campus.
We suggest using a plugin such as Breezy that allows you to position
elements freely within the navigation page and to set conditional visibility for
blocks.
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In any case, whichever plugin you use, make sure it has the possibility of
organising the material in blocks and that it has a visual editor.

The first block you will have to place in your pages will be
the main header to which you can give a background
colour and which you will then divide into three columns:

In the first column you will insert the main logo and link
it to the homepage itself
The second column can be left empty as a separator
In the third column you will insert the menu

STEP 1STEP 1

With Breezy you can make a block global so that it appears
automatically on all pages. So go to your header options and
tick the option ‘Make it global’. This way it will
automatically appear on all newly created pages.

STEP 2STEP 2

Select a background image for your homepage, to be
shown right below the header, at full size. Set the image as
‘cover’ and remove any margins or padding.

STEP 3STEP 3

You can now start arranging the buttons you wish to
display on the homepage.STEP 4STEP 4

We suggest that each background image realistically represent the
background of the environment you want to simulate on the page. For
example, the homepage could be the outdoor area of the campus or school,
the entrance could be the central corridor, and so on.

Some of them will lead directly to other pages, some will open a menu from
which you can select other options, and some will open a pop-up with text and
images.
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1.5. MAIN FEATURES

Visit https://calendar.google.com/ and log in with the
account you want to use as administrator of the platform.STEP 1STEP 1

On the left side of the screen, locate the “My calendars”
section.STEP 2STEP 2

Click the three dots next to a calendar name and select the
“Settings and sharing” option:STEP 3STEP 3

1.5.1. Embedded Calendar

A good way to show important dates, appointments, opening and closing
dates of courses offered and so on is to have a shared calendar.

You can embed the Google calendar in your WordPress platform.

To embed a Google Calendar on your website, Google will provide a piece of
code for you to use. To find your embed code, follow these steps:
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Scroll down to the “Access permissions for events” sectionSTEP 4STEP 4

Make your calendar public by ticking the “Make available to
public” checkboxSTEP 5STEP 5

Scroll down further to the “Integrate calendar” section. Copy
the full code in the “Calendar ID” box.STEP 6STEP 6

Go back to your wordpress editor and download the Pretty
Google Calendar plugin.STEP 7STEP 7

Now you can use a shortcode to generate an embedded
calendar on the page where you want to display it (it can be
the homepage, the admission page, the administration and
so on). 

STEP 8STEP 8

You can also have several calendars according to your
different needs (one for the general public, one for the

students of course A, one for course B, etc.)

The shortcode is structured this way:

[pretty_google_calendar wrapper="div" wrapper_class="calendar"
gcal="XXXcalendarIDXXX" views="dayGridMonth" show_today_button="hide"]
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1.5.2. Contact form

On the administration pages, we recommend that you include a number of
contact forms according to different needs.

First of all, you should have a registration form that allows users to apply.

You have two possibilities:

1) Self-registration: in this case you can use a plug-in such as User
Registration that allows the user to set the username and password
themselves, along with a range of other personal information.
 You can set the registration mode as direct or subject to approval. The
default status of the new user during registration is Subscriber. You can
later change its status and assign it to a certain category later on.

2) Application for registration: in this case the registration form will be a
contact form, which you can create from your WordPress template or by
choosing from the available plugins.
The user will be asked to add his/her data and all the useful information for
the creation of a profile, and the form will be sent to the administration
email. The site administrator will then have to manually add the user to the
user list, assign him/her the definitive role and then send the registration
confirmation with the credentials for access.

Other forms: if necessary you can include other forms such as request for
course change, general information, mobility applications, etc.

Depending on the type of form, it must be displayed on a specific page, either
public or private and subject to login or not.
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1.5.3. Chat Flows

The virtual campus should support two types of chat.

The first is an introductory chat with administrative staff that users
can engage in from the public service pages.

To implement it, you can download the plugin called HubSpot and
follow these instructions:

In your HubSpot account, navigate to Automations > Chatflows.
In the upper right, click Create chatflow.
Select Website.
On the Workspace page:

Click the dropdown menu to select an inbox or help desk.
You'll only be able to select inboxes with a connected channel. 
To change the language of your chatflow from English, click
the Select a language dropdown menu and select another
language.
Click Next.

On the Chatflow page, in the left sidebar, select the option Live
chat.
Click Create.

You'll be redirected to the Build tab of the live chat setup. Customise
the chat widget behaviour and create a welcome message that will
greet your visitors.

To customise the message that appears when a visitor first starts
a chat, click Welcome message to expand the section then enter
text in the Write a welcome message text box.

The bot will appear as a chat widget on your website pages where a
visitor can start a conversation. Use the bot to gather initial
information about the visitor before a member of your team takes
over the conversation.

More detailed instructions
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The second type of chat is internal, dedicated to users with a login
(among students or between teacher and students), but we’ll cover
it in the section regarding User Management.

1.5.4. Library

To create a library with different types of books belonging to different
categories and keywords you can use WordPress Posts.

Go to Posts > Add a new post and give it the title of the
digital resource you are going to display.STEP 1STEP 1

In the body of the post, write a short summary of the
content of the book, making sure the summary contains all
the relevant keywords that can help a user find that
resource.

STEP 2STEP 2

Upload the digital resource on the page, in ‘preview’ mode.STEP 3STEP 3

If you do not want to add a description, but only a list of
keywords, you can add them as text and then set the text
colour as white or the same colour as the background.

From the general post options assign it a category. This
category could be generically ‘Books’ or divided by course of
study.

STEP 4STEP 4
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Then go to your Library page and add two buttons
connected to two features:STEP 5STEP 5

1) Search bar: add a search block where the user can search by title or keyword
and will be taken back to the post(s) where the searched digital resource
appears

2) Full catalogue: add a block allowing the display of all posts in a given
category. This way, if you have assigned specific categories to Posts in advance,
users will see all the material on a certain topic, or in general all the books in
the library. We advise you to add pagination to this block.
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WordPress provides a number of predefined user roles which are, in ascending
rank order:

Subscriber
Contributor
Author
Editor
Administrator

These roles will be retained and will be used for the preliminary phase of
setting up the platform and enrolling new users, but in our case we must
create a series of other roles that will define the various players involved in the
virtual campus.

2.1. DEFINITION OF USER TYPES

To create a new role we need to go to Users > Roles > Add
Role.STEP 1STEP 1

At this stage we will have to decide what structure to give to
our campus.STEP 2STEP 2

First of all, we can create the role of a Teacher who will be in
charge of conducting the video lectures, following the
students through their studies and monitoring their
progress.
We can have more than one type of teacher if we want to
assign certain professors to one course of study, for
example.

STEP 3STEP 3
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Then we can create the Administrative role, which will have
the task of evaluating the course and the technical
demands of the students. We will be able to create several
administrative roles to be assigned to different functions
(e.g. a mobility manager, a certificate manager, etc.).

STEP 4STEP 4

And finally, we will have to create the Student role. We will
create as many student types as there are courses we want
to offer, so that each student only sees the material
dedicated to him/her.

STEP 5STEP 5

2.1.1. How create groups of students

If we want to create subgroups for group work in the lab in
which only part of the class group participates, then we will
also need to create subgroups in the roles, e.g. Students
Course 1 - Group A - Students Course 1 - Group B.

STEP 1STEP 1

Now that we have defined roles, we can return to the main
menu and set the conditional visibility of private pages for
the roles we have created.

STEP 2STEP 2

The Students page, for
example, should only be
seen by students in all
class groups, the teacher
page only by teachers,
and so on.

STEP 3STEP 3
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The plugin will be used to manage registration forms that should appear in the
administration pages, either as a plugin or as a stand-alone page, as preferred.

After activating it, you can configure settings to define which fields to include
in the form and customise email notifications for new users.

The newly registered user will appear in the list of WordPress users.

The site administrator can then assign the user role according to the student's
request or the admin's assessment.

In addition, the plugin allows you to manage user profiles directly from the
WordPress control panel. You can use the provided shortcodes to insert a user
profile page in the platform.

2.2. USER REGISTRATION AND PROFILE

Download the plugin here

To manage user registration and profile management on WordPress, we
recommend using the User Registration plugin.
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[display-posts wrapper_class="post_grid" include_date="true"
category="XXXYOUR_CATEGORYXXX" include_excerpt="true"
image_size="thumbnail" include_title="true"
excerpt_more="Read more" excerpt_more_link="true"
include_link="false"]

2.3. NEWS

News can also be customised according to the user.

News items are inserted as Worpress posts (see paragraph 1.5.4 to learn how to
add a new post).

You can add one or more categories to the post, depending on the types of
users you want to show the piece of news to.

Go to the page where you want to display your news (it can be a dedicated page
or a pop up) and insert this HTML code:

Then assigns the block in which this code appears a conditional visibility only to
users of the category or categories indicated in the code.

In this way you can have on the same page the news customised according to
the user accessing the page.

Where students can learn about the latest news, important events,
deadlines...
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Private
Messaging:

Users can send direct, private messages to other users
on the site.
Notifications are sent when a user receives a
message.

Group
Messaging:

Users can create and join groups for chatting, which is
ideal for community-based sites such as our virtual
campus.
Group admins can manage who can send messages
and who can view the group.

Real-Time
Notifications:

Users are notified in real time when they receive
messages or when certain events occur in the chat,
making it feel more like a live chat system.

Emoji and
Media Support:

Users can send emojis, images, and other media in
their messages.
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2.4. INTERNAL CHAT
The section where they can talk, collaborate and interact with other
students in the same course.

We can simulate the human interaction carried out in a school cafeteria by
dedicating a single page to a live chat among students and teachers. 

The background image can be that of a cafeteria or any other aggregation area
where people meet for informal conversations. 

We can use Better Messages plugin that allows site users to communicate with
each other in real-time. It offers a variety of features, including private
messaging, group chats, and more.

Download the plugin here

THE PLATFORM FOR THE PLATFORM FOR YOUR OWN E2.0C CENTERYOUR OWN E2.0C CENTER

https://wordpress.org/plugins/bp-better-messages/


User Mentions:
Conversations are organised in threads,
allowing users to easily navigate through past
messages.

Message History:
Users have access to a history of their
messages, so they can revisit old conversations.

Searchable
Messages:

Users can search through their conversations
for specific messages or keywords.

Customizable
Themes:

The look and feel of the messaging interface
can be customised to match your website's
branding.

Message Filtering
and Spam Protection:

Tools to filter inappropriate content or prevent
spamming via the messaging system.
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All the above mentioned options can be set in the first tab of the plugin settings. 

2.4.1. How to set restrictions

On the Restrictions tab, you can setthe "Role to Role Restrictions" feature that
allows you to define which user roles can send messages to each other within
the Better Messages plugin.  
You can decide whether by default all users are:

Allowed to message everyone: in this case each type of user (students of
various courses, teachers, etc.) are able to talk to everyone indiscriminately.
However, you can add some exceptions to the rule and indicate which
groups of users you do not want to meet

Not allowed to message everyone: in this case you will have to set a general
message saying: “You can only chat with students from your own course”
and you’ll have to select single categories of users who can talk to each
other. 
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2.5. GROU`P WORK

Allowing work groups in a virtual campus is crucial because it fosters
collaboration and teamwork, enabling students to share diverse perspectives
and ideas, thus overcoming the classic limitation of distance learning.

The platform includes a Laboratory section. The laboratory is a tool for
collaborative work among students. From this section students can write a
paper with other students, and discuss the topic of the paper with the teacher. 
In addition, from the lab students have the possibility to use the OpenAI AI:
ChatGPT as a free support. 

The lab is made of two main items, shared documents and AI support.

2.5.1. Shared Documents

A Google document will act as a virtual whiteboard in which the users involved
can collaborate.

You can place the document inside the Lab page in this way:

Adjust the Doc’s PrivacySTEP 1STEP 1

Before sharing any Google Docs
file, make sure the document is
set to public. To change the
privacy setting, view the doc and
click the “Share” button at the
top right corner of the screen to
make it visible to anyone:
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Obtain the Google Doc Embed CodeSTEP 2STEP 2

4. Click on the “Embed” tab.
5. Click the “Publish” button to reveal your file’s embed code.

You can go to your WordPress editor now:
6. Add a ‘shortcode’ element block in the page you want to use as Lab
7. Copy the shortcode.

The element you will share will have a syntax like this: 

<iframe src=‘https://docs.google.com/document/d/XXXCODEXXX/edit’
width=‘1000’ height=‘700’></iframe>

You can modify width and height freely, to better fit your page disposition.

Google will provide you with a piece of code for you to use to embed any of the
following content on your site:
To find your embed code follow these steps:

Open your document, sheet, or presentation.1.
Click on “File” in the upper left corner.2.
Choose “Share” then select the “Publish to web” option3.
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2.5.1. Shared Documents

Create an Open AI accountSTEP 1STEP 1

In the dashboard create a new project and inside the
project select ‘create new secret key’.STEP 2STEP 2

Save the secret key.STEP 3STEP 3

Go back to your WordPress editor and follow these steps:

From the main dashboard select Tools > Theme file
editor 
Select the file functions.php*.

STEP 4STEP 4

In the same page, you can add a support window with an AI service that answers
general questions.

To do so, follow these steps:

Be careful: make a backup copy of the php file before
changing it! You can always reload if something goes
wrong.

Then add these two code snippets to the bottom of the file:STEPSTEP    55

THE PLATFORM FOR THE PLATFORM FOR YOUR OWN E2.0C CENTERYOUR OWN E2.0C CENTER



27

Code for the request
// set an endpoint to connect OpenAI API

add_action('wp_ajax_chatgpt_request', 'handle_chatgpt_request');
add_action('wp_ajax_nopriv_chatgpt_request',
'handle_chatgpt_request');

function handle_chatgpt_request() {
    // Verifica se è stato passato un messaggio
    if (!isset($_POST['message'])) {
 wp_send_json_error('Messaggio non fornito.');
 wp_die();
    }

    $message = sanitize_text_field($_POST['message']);
    $api_key = 'YOUR-SECRET-KEY'; 

// Here above substitute with your API key

// Set data for the request

    $data = [
 'model' => 'gpt-3.5-turbo-0125', // Modello di OpenAI
 'messages' => [
  ['role' => 'user', 'content' => $message]
 ],
 'max_tokens' => 150
    ];

// Configure the cURL request to call the OpenAI API

    $response =
wp_remote_post('https://api.openai.com/v1/chat/completions', [
 'headers' => [
  'Authorization' => 'Bearer ' . $api_key,
  'Content-Type' => 'application/json'
 ],
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 'body' => json_encode($data),
 'method' => 'POST',
    ]);

// Check reply

    if (is_wp_error($response)) {
 wp_send_json_error('Errore nella richiesta.');
    } else {
 $body = wp_remote_retrieve_body($response);
 $result = json_decode($body, true);

 if (isset($result['choices'][0]['message']['content'])) {
  $reply = $result['choices'][0]['message']['content'];
  wp_send_json_success($reply);
 } else {
  wp_send_json_error('Errore nella risposta di OpenAI.');
 }
    }

    wp_die();
}

// Include the JS to handle the AJAX request

add_action('wp_enqueue_scripts', 'enqueue_chatgpt_script');
function enqueue_chatgpt_script() {
    wp_enqueue_script('chatgpt-script',
get_template_directory_uri() . '/chatgpt.js', ['jquery'], null,
true);
    wp_localize_script('chatgpt-script', 'chatgptAjax', [
 'ajax_url' => admin_url('admin-ajax.php')
    ]);
}.
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Code for the reply
// Insert this JS code directly into the functions.php file, right
after the first one
add_action('wp_footer', function() {
    ?>
    <script type="text/javascript">
    document.addEventListener("DOMContentLoaded", function() {
// Message sending management
         document.getElementById("chatgpt-
submit").addEventListener("click", function() {
              const userMessage =
document.getElementById("chatgpt-input").value;

              jQuery.ajax({
                url: chatgptAjax.ajax_url,
                type: 'POST',
                data: {
                    action: 'chatgpt_request',
                    message: userMessage
                },
                success: function(response) {
                    if(response.success) {
                         document.getElementById("chatgpt-
response").innerText = response.data;
                    } else {
                         document.getElementById("chatgpt-
response").innerText = "Errore nella risposta: " + response.data;
                    }
                },
                error: function() {
                    document.getElementById("chatgpt-
response").innerText = "Errore nella richiesta.";
                }
              });
         });
    });
    </script>
    <?php
});
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<!--HTML code for the ChatGPT interaction form -->

<div id="chatgpt-container" style="font-size: 32px; color: #333;">
    <label for="chatgpt-input" style="font-size: 32px; color:
#550000;">Ask a question:</label>

    <input type="text" id="chatgpt-input" placeholder="Submit your
request..." style="font-size: 18px; color: #555; padding: 8px;
width: 100%; margin-top: 8px;">

    <button id="chatgpt-submit" style="font-size: 18px; color:
white; background-color: #550000; padding: 10px 20px; border:
none; border-radius: 5px; margin-top: 10px; cursor: pointer;">

 Send

    </button>

    <p id="chatgpt-response" style="font-size: 30px; color:
#550000; background-color: white; margin-top: 15px; padding:
15px;">Respuesta:</p>
</div>

Save the file and close itSTEPSTEP    66

In the Lab page, insert this html code inside an ‘embed’ type
element. It is possible to customise all text elements in the
code and also font size and colours as preferred.

STEPSTEP    77
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We now come to the heart of the campus, namely the courses offered for all
members. The platform must allow fruition as close as possible to the real one
but at the same time enriched with interactive elements that we will see
below. 

3.1. MASTERCLASS

Install Zoom Integration Add-on STEP 1STEP 1

In addition to providing courses in the form of texts and video lectures, the
virtual campus can offer occasional or recurrent masterclasses to its students,
i.e. live classes in which students and teachers are connected via a video
conferencing tool, but without leaving the digital platform.

We must therefore be able to embed a tool for this purpose, and the best
solution is the Zoom platform, which can be embedded within the pages of
the digital campus.

We will then have a Masterclass page specifically created for this activity.

To embed a Zoom conference on your platform, you need to follow these steps:

Download the plugin here

Download the Events Manager for Zoom integration plugin, and install it
among your plugins.
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https://www.dropbox.com/s/ljvfq4xef8tdvgd/events-manager-zoom.1.0.zip?dl=1
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32

You will need to "create" a new OAuth App on Zoom.
If you haven't signed up for a Zoom account, you'll need a Pro plan for access
to their API, along with purchasing a Zoom webinar or rooms add-on should
you require either of these.
You'll start by visiting the Create App page on Zoom, and choosing to create an
OAuth app type.

STEP 2STEP 2

Access to the page

Create an OAuth App on Zoom

Here, you should select the 'Account-level app' and select NOT to publish your
App. 
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You'll immediately be provided with your App Credentials. Copy the ID and Key
over to your EM Zoom Settings, then save your settings.

STEP 3STEP 3 Copy Client ID and Secret Key 

You will need to enter a Redirect URL for OAuth to connect your account with
Events Manager. This URL is found on your EM Zoom Settings, and would look
similar to the following:

https://yoursite.com/wp-admin/admin-ajax.php?
action=em\_oauth\_zoom&callback=authorize

Additionally, you should also enter https://yoursite.com to the Whitelist URL
textbox as well.

STEP 4STEP 4 Redirect and Whitelist URL 
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https://yoursite.com/wp-admin/admin-ajax.php?action=em%5C_oauth%5C_zoom&callback=authorize
https://yoursite.com/wp-admin/admin-ajax.php?action=em%5C_oauth%5C_zoom&callback=authorize
https://yoursite.com/
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The scopes you need to authorise will vary on whether you want access to
Meetings, Webinars and/or Rooms, enable the 'User' scopes, and also the
specific ones you need:

STEP 5STEP 5 Select the Scopes

Users View all user information (user:read:admin)

Webinas
View and manage all user webinar
(webinar:write:admin)

Meetings
View and manage all user meetings
(meeting:write:admin)

Rooms
View all users' Zoom Rooms information
(room:read:admin)

Note that if you change your mind later on, you'll need to disconnect and
reconnect your account (see further down), although you don't need a new
Client ID and Secret Key.

Aside from these settings, you only need to enter the minimal required
information to connect Events Manager with Zoom. Ensure on the Activation
step there are no errors.

STEP 6STEP 6 Complete the app forms 
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Once you have built your app and saved your app credentials, you will see the
option to connect an account, like so:

STEP 7STEP 7 Connect your account 

Click the 'Connect' button. You will be forwarded to Zoom where you will need
to approve the App, then redirected back to a confirmation page.

When you visit your EM Zoom Settings again, you'll now see a connected
account:
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Now that you've connected your Zoom account, it's time to enable the Zoom
location types you'd like to use. You can do this by visiting the EM Zoom
Settings page, and open the General Options further up. Make sure locations
are enabled in Location Settings and then make sure the Zoom items you'd
like to use are checked, then save your settings.

Once you've done this, you will now see the available Zoom options on your
location settings whilst creating an event.

STEP 8STEP 8 Enable Location Types 

From the plugin setting Add a new event. 

You will be asked to add a title and then add all meeting information as you
would do if you were creating the event in Zoom.

STEP 9STEP 9 Create an event

After saving the event and opening it again, you will find a shortcode that can
be copied and pasted inside an iframe lament type in the page dedicated to
the Masterclass. The code may look like this:

[zoom_meeting_post post_id="XXX" template="boxed"]

You can modify the view of the embedded window by changing the attribute
“boxed” into “none”.

All users visiting the page will therefore see the incoming masterclass, with a
countdown to the start. When it starts there will be a live video conference on
the same page. You can set the conditional visibility of the blocks in which the
embedded Zoom call appears so that more than one masterclass can be
placed on the same page and each one is assigned to a different type of
student. 

STEP 10STEP 10 Copy your shortcode
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3.2. COURSES
The platform supports the fruition of SCORM (Sharable Content Object
Reference Model) content.

SCORM files are primarily used for e-learning courses and help ensure that
content and the results are trackable. 

Here is a step-by-step guide on how to create a SCORM package.

3.2.1. Creation of SCORM content

Create Your Course ContentSTEP 1STEP 1

Before converting your course into SCORM format, you need to create the
actual content, which could include:

Text content
Images
Videos

We suggest creating the exercises separately, as they will then be added
separately on the platform.

Tools to create course content include:
PowerPoint (with SCORM add-ins)
Articulate Storyline
Adobe Captivate
Lectora
iSpring Suite

These tools offer built-in features to create SCORM-compliant content directly,
which simplifies the process.
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Choose the SCORM VersionSTEP 2STEP 2

SCORM has different versions, with SCORM 1.2 and SCORM 2004 being the
most common. 

The version you choose depends on the requirements of your LMS and your
content’s needs:

SCORM 1.2 is simpler and more widely supported by older systems.
SCORM 2004 offers more features and flexibility (like better tracking and
sequencing).

If you're using an authoring tool (like Articulate Storyline or Adobe Captivate),
you can typically choose the version when exporting your course.

Export Your Course to SCORM FormatSTEP 3STEP 3

If you're using an authoring tool, you can export your course directly to SCORM.
Here’s how to do it in a few popular tools:

Using Articulate Storyline:
Open your project in Storyline.1.
Go to the "Publish" tab.2.
Select LMS as your publishing option.3.
Choose SCORM 1.2 or SCORM 2004 depending on your needs.4.
Click Publish, and the SCORM package will be created as a ZIP file.5.

Using Adobe Captivate:
Open your course in Captivate.1.
Go to File > Publish.2.
In the Publish Settings, choose HTML5 for mobile compatibility.3.
Under LMS options, select the SCORM version (1.2 or 2004).4.
Choose a location to save the SCORM package and click Publish.5.

Using iSpring Suite:
Create your course in PowerPoint using iSpring Suite.1.
After finishing, click on the Publish button.2.
Select LMS as the output type.3.
Choose SCORM 1.2 or SCORM 2004.4.
Click Publish, and a ZIP file with SCORM content will be generated.5.
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Organize the SCORM FilesSTEP 4STEP 4

After exporting the SCORM content, you’ll receive a ZIP file containing several
components:

HTML files – These files are used to display the content in the browser.1.
JavaScript files – These handle tracking and communication with the LMS
(using the SCORM API).

2.

Manifest file (imsmanifest.xml) – This is a crucial file that outlines the
structure of the SCORM package. It lists all the course files and includes
metadata (title, description, version, etc.).

3.

Media files (images, audio, video) – Any media assets you included in the
course.

4.

Tracking files – SCORM packages often track student progress, and these
files are used for that purpose.

5.

Open the zip file and delete the 4 files with the .cur extension, otherwise they
will create problems when importing onto the platform.
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3.2.2. Uploading SCORM files to the platform
We suggest using the Master Study LMS plugin. 
After installing it, follow these steps for customisation in the Settings section:

Go to the General tab and align the colours to those of your
platform theme.STEP 1STEP 1

Then go to the Courses tab and select the page where you
want to display the courses. STEP 2STEP 2

Customise the course display (number of courses per row,
page style, etc.).STEP 3STEP 3
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Go to the Reports and Analytics tab and set to “on” the
options: Reports for instructors and Reports for studentsSTEP 4STEP 4

Go to the Quizzes tab and choose how you want to use the
quizzes. Further customisations can be made within the
individual quizzes.

STEP 5STEP 5

Go to the LMS page tab and select a user account page and
certificate page.STEP 6STEP 6

In the Addons page, activate the following addons:
Certificate Builder
LMS Forms Editor
Media File Manager
Scorm
Statistics and Payout
Multi-instructors
Prerequisites
The Gradebook

At this point, you can return to the WordPress user management and you will
see that new user roles have been added. 

You will be able to assign the role of Instructor to users who will be in charge
of uploading lessons, holding masterclasses and monitoring student progress.
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3.2.3. Add your materials

Go to MasterStudy LMS > Courses.
Click on Add New to create a new course.
Fill out the basic course information in the Settings tab

Course Title
Category (if applicable)
Description
Co-Instructor (if applicable)
Prerequisites: if you want a certain course to be available only when the
student has completed a previous course
Other settings like course difficulty, tags, etc.

STEP 1STEP 1 Create a new Course

In the Curriculum tab, click on Import SCORM.
select the SCORM ZIP file from your computer and upload it.

STEP 2STEP 2 Add SCORM content to the Course

Once your SCORM content is added, complete any other course settings, and
click Publish to make the course live.

STEP 3STEP 3 Publish the Course

Courses are shown by default in descending order of loading. Therefore, the
course to be shown first must be of the most recent date.

STEP 4STEP 4 Manage display order and Author
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Click on Manage Students in the course list, and now you have two options:

Option 1: Add Students Manually
In the Manage Students page, you’ll typically see an option to add students
manually.
Search for existing users: Use the search bar to find users by their name,
email, or username.
Select the students you want to add to the course and click Add. You can
select multiple students at once if needed.
Once added, those students will be enrolled in the course.

Option 2: Bulk Add Students Using a List (CSV Import)
If you have a list of students (in a CSV file, for example), look for an import or
bulk add option in the Manage Students section.
Prepare the CSV file with the following necessary fields: username, email,
first name, last name, and any other relevant details that MasterStudy LMS
requires for user creation.
Upload the CSV file: There should be an option to upload the CSV. Once
uploaded, the students will automatically be enrolled in the course.
Confirm the bulk import and check if all the students appear in the Student
List for that course.

STEP 5STEP 5 Manage Students

Change the date in the quick edit settings from the course list
Modify the main Author from the same settings if necessary (you can
choose among the users who have been set as “instructor”). The Author of
the course will also see the statistics of enrolled students from his/her
profile. 
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3.2.4. Quiz management

In this mode, quizzes (final or intermediate) are uploaded in a single course,
separate from the course with previously uploaded SCORM content.

Under the Course section, click Add New Lesson.
In the lesson editor, select the lesson type as Quiz.
Click Add Quiz to create a new quiz.

Title and
Description

Provide a title for your quiz (e.g., "Module 1 Quiz") and a
description or instructions.

Passing Grade
Set the passing grade for the quiz. You can specify the
percentage or score required for students to pass.

The set Quiz details:

Add questions and answers:

In the quiz editor, click Add Question.STEP 1STEP 1

Select the question type (e.g., multiple-choice, true/false,
short answer).STEP 2STEP 2

Enter the question and possible answer choices. If it's
multiple-choice, mark the correct answer.STEP 3STEP 3

You can add as many questions as needed. Click "Save" after
each question to ensure it is added.STEP 4STEP 4

You can also set point values for each question.STEP 5STEP 5
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Time Limit You can set a time limit for the quiz if desired.

Attempts
Choose how many attempts a student can make on the
quiz.

Quiz
Completion
Settings

Decide if you want to automatically mark the quiz as
complete once the student finishes or set specific
completion criteria.

Results Display
Set how and when students will see their results
(immediately after submission, after the quiz is graded,
etc.).

Set Quiz options:

Publish the Quiz

After setting everything up, click Save or Publish to make
the quiz available to students.STEP 1STEP 1

As previously done with SCORM courses, edit display order,
instructor and manage students from the course list.STEP 2STEP 2

At this point, the students you have entered will see on their course page all
the courses and quizzes you have uploaded and assigned to them.
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3.2.5. Course page customisation

By default a display filter is shown on the course page that allows you to sort
courses by date, price etc.

If you want to hide it, you can do so with additional CSS by going to the
WordPress general menu under Appearance > Customise and writing these
lines in the additional CSS tab:

.courses_filters__activities .lms_courses {
display: none !important;
}

3.2.6. Management of students Statistics and Certificates

Statistics:

From the WordPress admin dashboard among MasterStudy LMS options, go
to Courses and select the course you want to manage.

Click on Analytics to view detailed statistics on student performance. You can
see:

Course Progress (Completion status)
Quiz Scores (If quizzes are used in the course)
Time Spent on the course
Course Enrollment Data (Which students are enrolled)
Individual student progress (including quiz attempts and results)
Download Reports: you can export reports in CSV format for further
analysis. Just click on the Export button (if available) in the statistics page to
download the data.

The statistics of all users can also be viewed from the front end of the author's
profile page.

In this case by going to Analytics and then browsing Engagement and
Students, the Instructor / Author will be able to see all the relevant statistics for
the students enrolled in his/her courses.
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Certificates:

Certificates can be issued using the specific menu item that will appear on
your WordPress dashboard after having installed MasterStudy LMS.

From this list you can see the default certificates template that can be
modified with your logo, information, instructor’s name, signatures and so on.

Edit your certificate(s) and save it.

Then go to the course list and assign the certificate(s) in the course settings:
Choose a certificate to be automatically assigned after the student has
passed the course;
Define the criteria for awarding the certificate, such as:

Passing grade for quizzes
Completion of course materials

The certificate will be automatically generated when students meet these
conditions.
Students will receive the certificate upon completing the course, either via
email or through their user dashboard.
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